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For an underlying symbol, the option chain shows the various strike prices by put and call designations, as well as expiry 

dates. You can also view options by specific strategies and analyze data points and strategies using the analysis chart. 

 

 Symbol Entry – allows entry of a symbol for the window 

 Go – enters symbol  

 Symbol Search – opens symbol search dialog 

 Select to view Calls & Puts, or view by strategy 

 Quick filter – allows quick filtering by expiration date and delivery type if applicable 

 Advanced filter – allows detailed filtering by expiration dates, strike prices, delivery type, volume and open interest  

 Refresh – refreshes the displayed information 

 Strike Price filter 

 Select to view option chain 

Select to view analysis chart 

 Customize – opens dialog to customize data elements displayed for underlying symbol. 

Right click on Option Chain fields and select Heading > Customize to change fields for the options 
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To customize columns for the option contracts, right click on the option column headers and select Heading, or select 

Customize icon  from toolbar and click Customize Option Table Fields. 

 

 Select from pre-defined views: Basic; Greeks; Price Range and Analytics. 

 Select Customize to define your own view 

To customize columns for the underlying symbol header, right click on underlying symbol header and select Fields, or 

select Customize icon  from toolbar and click Customize Equity Fields. 

 

 Select from pre-defined views: Mutual Fund; Stock Option; Stock; Index; Money Fund; ETF and Bond. 

 Select Customize to define your own view 

Right click in the Option Chain window and select Show Selected Option Symbol Details to enable an option data bar.  
This will show details for the currently selected option contract.  The fields shown in the bar can be customized by right 
clicking in the bar and selecting Fields. 
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Strike Ranges: 

There are built-in filters on the toolbar for the following: 

 In the Money: A call option is in the money when the strike price is below the spot price. A put option is in the 
money when the strike price is above the spot price.  

 Near the Money: A user definable number of out of the money options that are closest to being at the money.  

Define “Near the Money” in advanced filter (select icon  from toolbar) 

 Out of the Money: A call option is out of the money when the strike price is above the spot price. A put option is 
out of the money when the strike price is below the spot price. 

 All Strikes: Removes the strike price filters.  

 Extended strike price filtering is available using advanced filter (select icon  from toolbar) 

 

Due to more complex deliverables, the general in/out of the money rules defined above may not apply to adjusted 

options which are denoted with symbol   

Expiration Dates: 

 Select an individual expiration month from quick filter drop down on toolbar   

 Weekly expirations (options that expire on dates other than the third Friday of the month) are noted with “(W)” 
following expiration date 

 Quarterly expirations (options that expire on the last trading day of each quarter) are noted with “(Q)” following 
expiration date 

 Extended expiration date filtering is available using advanced filter (select icon  from toolbar) 

Calls/Puts: 

 Right click in the Option Chain window and select View Mode > Simple Column Mode (Calls only) or Simple 
Column Mode (Puts only) to enable display of only Calls or Puts. 

Delivery Type: 

 Select delivery type of Regular, Mini or All from the quick filter drop down on toolbar  

 Filter will only be available if the security supports mini options 

 Strike prices will be noted with icons to indicate Mini  and Adjusted  options 

 Delivery filtering is available using advanced filter (select icon  from toolbar) 

Advanced Filtering: 

Select filter icon  to expand / collapse the filter dialog to filer using a combination of expiration dates, strike prices and 

delivery types displayed, volume and open interest 



Page 4 | Option Chain 3402200 

 
 

Select display of option chain only, option chain & analysis chart or analysis chart only from main toolbar 

 

Analysis Chart Toolbar: 

 

 Analysis Parameter – allows user to select analysis parameter to be plotted 

 Option Type – allows user to select Call or Put for analysis 

 Refresh – refreshes the displayed data 

 

Analysis chart displays user selected option analysis parameter (Mark Price, Implied Volatility or Greeks) on y-axis against 

strike price on x-axis for all selected expiration dates 

Filters for Expiration Date, Strike Price and Delivery type will filter data displayed in chart 

Define font, line colors, chart position, line types, grid lines, data view display and data point marker settings for analysis 

chart from Right Click > Display Properties > Option Analysis Chart 

Right click on option symbol to take one of the following actions.  Selectable actions are determined by current holdings 

and approved option trading level.  To select a default account and other trading defaults (order type, duration, quantity), 

right click in Trade window and choose Trade Defaults and Properties > Option Trade Ticket 

 Buy to Open or Close 

 Sell to Open or Close 

 Buy / Write 

 Buy Vertical Spread 

 Sell Vertical Spread 

 Buy Calendar Spread 

 Sell Calendar Spread 

 Buy Diagonal Spread 

 Sell Diagonal Spread 

 Long Strangle 

 Long Straddle 

 Short Straddle 

 Short Strangle 

 Roll 
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Additional trading features: 

 Right click on ask price for a Buy Stop or Sell Limit order 

 Right click on bid price for a Buy Limit or Sell Stop order 

 Highlight a held option and another option (using ctrl or shift), then right click and select Roll to prepopulate the 
trade ticket with the specified roll order. 

Trading in underlying security: 

 Right click on underlying symbol for Buy or Sell 

 Right click on bid price of underlying symbol for a Buy Limit or Sell Stop order 

 Right click on ask price of underlying symbol for a Buy Stop or Sell Limit order 

You can use the option chain to perform analysis of several option strategies 

To begin, select a strategy from the Calls & Puts menu 

 

Use the quick filters or advanced filters to further refine which options are displayed 

The following data elements are shown for each of the option pairs 

Strike – Strike prices for the pair of options 

Symbols – Symbols for the pair of options 

Net Bid – Net bid for the pair of options 

Net Ask – Net ask for the pair of options 

Mid – Average of Net Bid and Net Ask 

M/G – Maximum Gain.  The maximum gain possible for the strategy with the selected options 

M/L – Maximum Loss.  The maximum loss that would be incurred for the strategy with the selected options 

B/E – Break Even.  The stock price (or prices) at which the strategy neither makes nor loses money with the 
selected options. 

R/R Ratio – Risk/Reward Ratio = Maximum Loss divided by Maximum Gain 
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 Right click on an option pair and select Open <name of strategy> to trade that option pair 

 

 Enable the analysis chart  from the main toolbar to plot the Mid-Point or Risk/Reward Ratio for each expiration 
date 

Use RTD (Installation Instructions) to display streaming real time data in Excel (Windows only). Once the plugin is 
installed, right click > RTD and select which data to copy, which can then be pasted into an Excel worksheet.  Data will 
continue to stream within Excel as long as MarketPro remains active. 

Select linking icon  to adjust window linking settings 

 With “Link to All” enabled, window will receive symbols selected from other windows (default) 

 With “Link to All” enabled, clicking on any option will send option to linked symbol windows (default setting – 
right click > Display Properties > Symbol Field to change action that takes place when selecting symbols ) 

 With “Symbol Broadcast Source” enabled, window will send entered stock symbols to other windows 

 Colors: If selected, window will only send/receive symbols from windows set to the same color or link to all in link 
settings  

 Right click on the option symbol to launch another symbol-based window with the symbol in context 

 Right click on the stock information to launch another symbol-based window with the symbol in context 

 

 

 

 

 

 

 

 

 
 

http://download.esignal.com/products/marketq/baml/rtd/rtd.htm
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Select the options icon  to adjust window options 

 New - Creates a new window.  Select the window type, then select the position of the new window, or choose “In 
this window” to replace existing window with the new window. 

 Show Window Title – Un-selecting this option hides the window description.  Re-check to display window 
description. 

 Maximize/Restore – Only displayed if window does not fill entire page.  Maximize expands the window to fill the 
current page.  Restore will set back to original size. 

 Show Titlebar - Un-selecting this option hides the title bar that is displayed at the upper left.  To show the title bar 
again, move cursor up to the top of the window until the cursor pointer turns to a hand, then right click and re-
check Show Titlebar, or from main menu select View > Show Title Bars (this will restore all hidden title bars) 

 Show Titlebar description – Display custom description as defined using Customize Titlebar Description 

 Customize Titlebar Description… – Replaces default description and titlebar controls with a customizable 
description.  For symbol specific windows, use #sym to insert currently selected symbol into custom description.  
Click anywhere on the titlebar to restore default description and titlebar controls. 

 Show Footer - Un-selecting this option hides the footer.  Re-select to display the footer again. 

 Copy Out (displayed when window is docked) – Copies this window as a floating (stand alone) window.  This 

action can also be performed using the Copy Out icon  

 Attach (displayed when window is un-docked) – Moves a floating (stand alone) window inside the active page  

 Cut Window - copies the window to the clipboard, and removes the window from the workspace.  Once copied, 
click Edit > Paste Options Chain to add the window to the workspace using default settings for adding a new 
window  (use View > Preferences > Workspace > Open new window by default to change how new windows are 
added to the workspace) 

 Copy Window – copies the window to the clipboard, with all settings.  Once copied, click options icon and choose 
Paste Options Chain, then choose a position for copy of window.  Or click Edit > Paste Options Chain to add the 
window to the workspace using default settings for adding a new window 

 Copy Window Image – copies an image of the window to the clipboard, which can then be pasted into an email, 
document or image editing application 

 Send Image by E-mail… - creates new email message using default email client with screenshot of current window 
attached 

 Take Custom Screenshot – drag mouse to define an area to copy, then paste into image editor 

 Print – Prints this window 

 Help – loads this help file 

 Display Properties 

o Text & Colors – font setting for display elements 

o Direction – define colors and columns for quote display based on price direction, volume and open interest 

o Symbol field – turn on/off indicators for open positions / active orders, and default actions on click / double 
click 

o Gridlines – display and color of gridlines 

o Formatting – general window formatting 

o Black Scholes – define parameters used in Black Scholes calculation 

o Heat Map – enable/disable heat map display and configure columns to display using heatmap coloring 

o Quotes – define display properties for quote information 

o Option Analysis Chart – define font, line colors, chart position, line types, grid lines, data view display and data 
point marker settings for analysis chart 

 Empty - (displayed when window is docked) – removes the window and leaves an empty space in which a new 
window can be added 

 Close – removes the window.  Any remaining windows will be adjusted to fill empty space 
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Fields for Option Data displayed 

% Change Percentage price change for current trading session 

% In/Out of Money Percent difference between last price and strike price 

Ask Ask price (lowest available selling price) 

Ask Exchange Exchange of ask price 

Ask Size Quantity available to sell at ask price 

Basecode Determines the method of Price base code translation (1/10, 1/100, etc) 

Bid Bid price (highest available buying price) 

Bid Exchange Exchange of bid price 

Bid Size Quantity available to buy at bid price 

Bid/Ask Size The bid and asks size (side-by-side in same cell) 

Bid-Ask The bid and ask price (side-by-side in same cell) 

Contract Deliverable Number of shares represented by an option contract 

Contract High The High over the life of the Contract 

Contract High Date The Date that the Contract High was set 

Contract Low The Low over the life of the Contract 

Contract Low Date The Date that the Contract Low was set 

Date Date of last update - can be trade or quote update 

Days Til Expiration Options: Number of days until the expiration of an option contract 

Delta The neutral hedge ratio, or the expected change in the option premium given a one point 
change in the price of the underlying Instrument (Measure of the options sensitivity to changes 
in the Underlying Instrument) 

Description Equities, Indices, futures: Name. ETFs, ETNs & Mutual Funds: Issuer. Currency: Base Currency. 
Options: Underlying, Month, Strike, Type. 

Description2 For mutual funds, the name of the fund (i.e., the "issue"). Equities with SEDOLs will display 
SEDOL 

Exchange Exchange security is listed 

Expiration Options and futures: Date of expiration. 

Gamma Measure the expected change in Delta, given a one point change in the value of the underlying 
Instrument (Measures the stability of the options Delta) 

High Highest trading price for the current session 

ImpVol Calculated by using an option pricing model and is the amount of price change that can be 
expected over a given period of time, expressed as a percentage. 

Intrinsic Value Difference between the last price for underlying security and the option strike price.    Only 
calculated for options in the money 

Issue Description ETFs: Part of Instrument's name. 
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Last Last price the asset has traded 

Last Trade Time Date and Time of Last Trade 

Last+Change Combination of the Last and the Change between the Last traded price, and the previous 
session's close 

Last+Settle Last settlement 

Low Lowest price traded in the current session 

Market The Average of the Bid & Ask. If Bid=0 it will be Ask. If Ask=0 it will be Bid. If neither are present 
than Market will equal Recent. 

Mid Price The Average of the Bid & Ask. If Bid=0 it will be Ask. If Ask=0 it will be Bid. If neither are present 
than Market will equal Recent. 

Mid Price Change Percentage Mark Price change for current session 

Midpoint Mid price between session's High and Low prices 

Net Change Difference between the Last traded price, and the previous session's close 

NewSettlement   

Old Set IV Yesterday's Implied Volatility at the close price. 

OldSettlement   

Open Opening price 

Open Interest Options: The number of outstanding option contracts in the exchange market  

Option Type For options only, either Put or Call 

Option Type (S/NS) Option delivery type, S=Standard, NS=Non Standard, i.e. Adjusted deliverable 

Previous Close Last price the asset traded in the previous trading session 

Recent Last Trade or Settlement, whichever is more current. 

Rho Measures the expected change in the option Premium, given a 1% change in the Domestic 
Interest Rate. 

Root Options: Complete symbol of the underlying asset 

Strike Options: Strike price 

Theoretical Price The value of an option as calculated by the option pricing model using the previous sessions 
closing implied volatility. 

Theta Reflects expected change in the option Premium, over one day (Measure of time value decay). 

Tick Either + or - to representing the change from the previous Trade Price when instrument is 
currently trading and a "C" when the session is closed for Equities and Options and a "S" when 
Futures contracts are settled 

Time Time of the last update (Includes Bids / Asks) 

Time Value Difference between the option last price and its intrinsic value.   Only calculated when intrinsic 
value is defined. 

Trade Exchange Exchange, market center, where last trade occurred 

Trade Size Quantity of last trade 

Underlying symbol Options: Complete symbol of the underlying asset 

Vega Measures the expected change in the option Premium, given a 1% change in the Implied 
Volatility of the option (Measures sensitivity to shifting volatility levels). 
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Volume The number of shares traded from the current day's market opening until the reported trade 
time.  

 

Fields for underlying security 

$ Change Week $ change of current price to closing price 1 week ago. 

% Change Percentage price change for current trading session 

% Change 1 Month % Price change of current price to the mean of high & low price from one 
month ago 

% Change 3 Month % Price change of current price to the mean of high & low price from three 
months ago 

% Change 6 Month % Price change of current price to the mean of high & low price from six 
months ago 

% Change Month % Price change of current price compared to closing price from one month ago 

% Change Week % Price change of current price compared to closing price from one week ago 

% In/Out of Money Percent difference between last price and strike price 

12Mo % Return Percent difference between last night's close and the close 52 weeks ago. 

12Mo %Tot Return Percent difference between last night's close and the close 52 weeks ago, plus 
any dividends received. 

12Mo Div Pd Value of dividends paid per share over 12 month period. 

12Mo Prev Close A security’s closing price from 12 months ago 

1Mo % Ret Adj % return over 1 month 

1Mo % Tot Ret Adj % return over 1 month with the addition of any dividends paid out over 1 
month. 

1Mo Begin Pr Adj A security’s closing price from 1 month ago 

1Mo Cash Div Pd Sum of dividends paid for 1 share over the past 1 month 

1Mo SpinOff Returns the following values of which are applied to return calculations based 
on a spinoff corporate action. 
• S = The return has been zeroed out due to a spinoff 
• N = The return is zero for other reasons (likely, no price on one of the two 
dates) 
• Y = the return is present 

3Mo % Ret Adj % return over 3 month 

3Mo % Tot Ret Adj % return over 3 months with the addition of any dividends paid out over 3 
months. 

3Mo Begin Pr Adj A security’s closing price from 3 months ago 

3Mo Cash Div Pd Sum of dividends paid for 1 share over the past 3 months 

3Mo SpinOff Returns the following values of which are applied to return calculations based 
on a spinoff corporate action. 
• S = The return has been zeroed out due to a spinoff 
• N = The return is zero for other reasons (likely, no price on one of the two 
dates) 
• Y = the return is present 

52Wk H Date Date the maximum price was reached in the previous 52 weeks 

52Wk High Maximum price for the last 52 weeks 

52Wk High Percent Below Percent Below 52 Week High using current price 
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52Wk L Date Date the minimum price was reached in the previous 52 weeks 

52Wk Low Minimum price for the last 52 weeks 

52Wk Low Percent Above Percent Above 52 Week Low using current price 

52Wk Range with Last Display the 52 week price range, low to high, along with the last trading price's 
relative position in the range 

6Mo % Ret Adj % return over 6 months 

6Mo % Tot Ret Adj % return over 6 months with the addition of any dividends paid out over 6 
months. 

6Mo Begin Pr Adj A security’s closing price from 6 months ago 

6Mo Cash Div Pd Sum of dividends paid for 1 share over the past 6 months 

6Mo SpinOff Returns the following values of which are applied to return calculations based 
on a spinoff corporate action. 
• S = The return has been zeroed out due to a spinoff 
• N = The return is zero for other reasons (likely, no price on one of the two 
dates) 
• Y = the return is present 

Annual Dividend If regularly paid (i.e., quarterly, monthly), this is the total dividends expected 
to be paid over the next 12 months. In some cases, the amount and timing of 
dividends are irregular, and therefore impossible to forecast - in those cases, 
we sum up dividends paid over the last 12 months. 

Annual Revenue Annual Revenue in millions 

Ask Ask price (lowest available selling price) 

Ask Exchange Exchange of ask price 

Ask Size Quantity available to sell at ask price 

Average Volume Average volume for previous 20 days 

Basecode Determines the method of Price base code translation (1/10, 1/100, etc) 

BETA A measurement of the sensitivity of a company's stock price to the overall 
fluctuation in the S&P 500 (S&P 500), or for Canadian listings, the Toronto 
Stock Exchange 300 Index. For example, a beta of 1.5 indicates that a 
company's stock price tends to rise (or fall) 1.5 percent, with a 1 percent rise 
(or fall) in the index price. 

Bid Bid price (highest available buying price) 

Bid Exchange Exchange of bid price 

Bid Size Quantity available to buy at bid price 

Bid/Ask Size The bid and asks size (side-by-side in same cell) 

Bid-Ask The bid and ask price (side-by-side in same cell) 

BlockTrade1 Number of trades between 1 and 49,999 shares 

BlockTrade2 Number of trades between 50,000 and 99,999 shares 

BlockTrade3 Number of trades over 100,000 shares 

BlockTradeTotalCount Aggregate number of block trades 

BlockTradeTotalVol Aggregate volume of block trades 

BlockTradeVol1 Aggregate volume of shares traded in trades between 1 and 49,999 shares 

BlockTradeVol2 Aggregate volume of shares traded in trades between 50,000 and 99,999 
shares 
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BlockTradeVol3 Aggregate volume of shares traded over 100,000 shares 

Book Value The book value of a company, in millions. 

Book Value per Share Book Value / Common Shares Outstanding 

BuyerID The TSX assigned ID number for the broker on the buy-side of a trade 
(Canadian securities only) 

Category Name Type of security 

Contract Deliverable Number of shares represented by an option contract 

Contract High The High over the life of the Contract 

Contract High Date The Date that the Contract High was set 

Contract Low The Low over the life of the Contract 

Contract Low Date The Date that the Contract Low was set 

Currency Currency the security trades in 

Current Inside Match Price The Current Inside Match Price reflects the price for which the number of 
Paired Shares and the number of Imbalance Shares are calculated. Please note 
that the Current Inside Match Price is determined by the price within the 
NASDAQ Inside where the maximum number of shares are paired, the 
imbalance is minimized and the distance from the bid-ask midpoint is 
minimized, in that order. If this field is null or blank, it is because there is no 
Current Inside Match Price for the specific security.  
 
Note: Market Depth qualification is required to use this field 

Current Ratio Total Current Assets / Total Current Liabilities, on a trailing 12-month basis 

CUSIP The 9-character identifier for North American securities 

Date Date of last update - can be trade or quote update 

Days Til Expiration Options: Number of days until the expiration of an option contract 

Delta The neutral hedge ratio, or the expected change in the option premium given a 
one point change in the price of the underlying Instrument (Measure of the 
options sensitivity to changes in the Underlying Instrument) 

Description Equities, Indices, futures: Name. ETFs, ETNs & Mutual Funds: Issuer. Currency: 
Base Currency. Options: Underlying, Month, Strike, Type. 

Description2 For mutual funds, the name of the fund (i.e., the "issue"). Equities with SEDOLs 
will display SEDOL 

Div, Date Annc Date the dividend was announced 

Div, Pay Date Date the dividend was/will be paid 

Div, Prev XDate Date of the previous ex-dividend date 

Div, Rec Date Record date of the dividend 

Div, Xdate The ex-dividend date of the most recently announced or paid dividend 
 
See Fundamentals window > Dividend History for more information on 
dividends 

Dividend The dividend farthest out in the future - almost always the most recently paid 
or announced dividend. 

Dividend Interval Number of days between dividend payments 

Dividend Yield Dividend Yield = (indicated annual dividend / current price) * 100 

EBITDA (TTM) Earnings before interest, taxes, depreciation, and amortization on a trailing 12-
month basis 
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EPS Earnings per share (TTM).  Sum of last 4 recently reported earnings (excluding 
extraordinary items and discontinued operations), divided by outstanding 
shares. 

EPS, Current FY Earnings per share for the current fiscal year 

EPS, Exp NextQ Estimated Amount of Upcoming Earnings 

EPS, Next FY Estimated earnings per share for the next fiscal year 

EPS, Next FYDt Estimated date for the release of the fiscal year’s earnings per share 

EPS, Next Two FY Estimated earnings per share for the fiscal year after next 

EPS, NextQDt Estimated Announcement Date for Upcoming Quarterly Earnings 

EPS, PrevQ Most Recently Reported Quarterly Earnings 

EPS, PrevQDt Announcements Date of Most Recently Reported Quarterly Earnings 

Exchange Exchange security is listed 

Expiration Options and futures: Date of expiration. 

ExtHours Last Price during extended hours trading 

ExtHours Change % Extended hours Percentage Change Value 

ExtHours Net Change Extended hours $ change Value 

Far indicative clearing price This field indicates the price level at which buy orders and sell orders match in 
the opening/ closing book. If this field is null or blank, this indicates one of two 
circumstances: 
 
• There are no on-open (or on-close) orders entered for the security; or 
 
• There is no substantial on-open (or on-close) interest on the opposite side of 
the market to execute all of the MOO (or MOC) orders on the other side. 
When this occurs, the No Indicative Price field displays either a Market Buy or 
Market Sell indicating that offsetting imbalance only orders should be entered 
on the other side of the market.  
 
For the midday opening process, the Current Inside Match Price, the Near 
Indicative Clearing Price and the Far Indicative Clearing Price will be equal. 
 
Note: Market Depth qualification is required to use this field 
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Flags Flags 
 
N News article today 
S Split Today 
R Record Date is today 
X XDiv Date is today 
P Pay Date is today 
S

E Significant event for security 
 
NASDAQ Filing Status codes. Off by default - right click > Display Properties > 
Flags to enable 
D - Deficient: Issuer Failed to Meet NASDAQ Continued Listing Requirements 
E - Delinquent: Issuer Missed Regulatory Filing Deadline 
Q - Bankrupt: Issuer Has Filed for Bankruptcy 
G - Deficient and Bankrupt 
H - Deficient and Delinquent 
J - Delinquent and Bankrupt 
K - Deficient, Delinquent, and Bankrupt 

Float Shares outstanding, less restricted shares 

Forward Earnings Date Date which the next earnings announcement is expected  

Forward P/E Current Fiscal Year Price per Share / Expected Earnings per Share, for Current Fiscal Year 

Forward P/E Current Quarter Price per Share / Expected Earnings per Share, for Current Quarter 

Forward P/E Next Fiscal Year Price per Share / Expected Earnings per Share, for Next Fiscal Year 

Forward P/E Next Quarter Price per Share / Expected Earnings per Share, for Next Quarter 

Forward P/E Next Two Fiscal Year Price per Share / Expected Earnings per Share, for next Two Fiscal Years 

Forward P/E Next Two Quarter Price per Share / Expected Earnings per Share, Next Two Quarters 

Gamma Measure the expected change in Delta, given a one point change in the value 
of the underlying Instrument (Measures the stability of the options Delta) 

Headline Count Number of headlines available 

High Highest trading price for the current session 

Historical Volatility 20 day close-to-close volatility 

ImpVol Calculated by using an option pricing model and is the amount of price change 
that can be expected over a given period of time, expressed as a percentage. 

Industry Industry group (sub section of Sector) 

Insider Owned % Insider Owned % = Shares owned by insiders / Shares outstanding 

Institution Owned % Institution Owned % = Shares owned by institutions / Shares outstanding 

Intrinsic Value Difference between the last price for underlying security and the option strike 
price.    Only calculated for options in the money 

ISIN International Securities Identification Number. A unique international code 
which identifies a securities issue. 

Issue Description ETFs: Part of Instrument's name. 

Last Last price the asset has traded 
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Last News Update Timestamp of the last news update 

Last Trade Time Date and Time of Last Trade 

Last+Change Combination of the Last and the Change between the Last traded price, and 
the previous session's close 

Last+Settle Last settlement 

Low Lowest price traded in the current session 

Margin Code Y = Marginable, N = Not marginable 

Market The Average of the Bid & Ask. If Bid=0 it will be Ask. If Ask=0 it will be Bid. If 
neither are present than Market will equal Recent. 

Market Cap Market capitalization - outstanding, non-diluted number of shares, multiplied 
by the current share price 

Mid Price The Average of the Bid & Ask. If Bid=0 it will be Ask. If Ask=0 it will be Bid. If 
neither are present than Market will equal Recent. 

Mid Price Change Percentage Mark Price change for current session 

Midpoint Mid price between session's High and Low prices 

Minutes Delayed Reports number of minutes a quote is delayed. 

Month Prev Close The price as of the last workday of the previous month 

Mov Avg 150 The average trade price over the most recent 150 business days, U.S. holidays 
and weekends excluded 

Mov Avg 20 The average trade price over the most recent 20 business days, U.S. holidays 
and weekends excluded 

Mov Avg 200 The average trade price over the most recent 200 business days, U.S. holidays 
and weekends excluded 

Mov Avg 50 The average trade price over the most recent 50 business days, U.S. holidays 
and weekends excluded 

MTD $ Change $ change of current price to closing price at the end of the previous month 

MTD % Change Percentage Change since the 1st of the Current Month 

MTD Div Paid The MTD dividend will be the sum of the cash dividends which have gone ex in 
the current month. 

MTD%RetAdj Percentage change between current price and last price of previous month - 
[(current price / previous month's end price) – 1] * 100 

MTD%TotRetAdj Percentage price change between current price and last price of previous 
month, plus any dividends received for that period [(current price + MTD cash 
dividends) / previous price] * 100 

Mutual Fund Category Type of Mutual Fund 

NAV Mutual Funds: Net asset value 
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Near indicative clearing price The crossing price at which orders in the NASDAQ opening/closing book and 
continuous book clear against each other. If this field is null or blank, this 
indicates one of two circumstances: 
 
• There are no on-open (or on-close) orders entered for the security; or 
 
• There is no substantial on-open (or on-close) or continuous book interest on 
the opposite side of the market to execute all of the MOO (or MOC) orders on 
the other side. When this occurs, the No Indicative Price field displays either a 
Market Buy or Market Sell indicating that offsetting imbalance-only or 
continuous market orders should be entered on the other side of the market. 
 
For the midday opening process, the Current Inside Match Price, the Near 
Indicative Clearing Price and the Far Indicative Clearing Price will be equal. 
 
Note: Market Depth qualification is required to use this field 

Net Change Difference between the Last traded price, and the previous session's close 

No indicative clearing price The No Indicative Price field displays either a Market Buy or Market Sell when 
there is no substantial on-open (or on-close) or continuous book interest on 
the opposite side of the market to execute all of the MOO (or MOC) orders on 
the other side.  This indicates that offsetting imbalance-only or continuous 
market orders should be entered on the other side of the market. 
 
Note: Market Depth qualification is required to use this field 

Note Displays note for security.  Add and edit notes from Tools > Notes 

Number of Market Shares Imbalanced This field is used for an IPO or trading halt opening process. The only time that 
an imbalance will be disseminated will be when there is a Market Buy or 
Market Sell condition. 
 
Note: Market Depth qualification is required to use this field 
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Number of Shares Imbalanced For the Opening Cross, this field indicates the absolute difference between the 
number of shares for early “Regular Hours”, Market On Open, Limit On Open 
and Imbalance Only orders on the buy side and the number of shares for early 
“Regular hours”, Market On Open, Limit On Open and offsetting Imbalance 
Only orders on the sell side eligible to be matched at the Current Inside Match 
price.  
 
For the IPO and trading halt opening process, imbalance information will only 
be disseminated when there is a Market Buy or Market Sell condition.  
 
For the Closing Cross, this field indicates the absolute difference between the 
number of shares for Market On Close, Limit On Close and offsetting 
Imbalance Only orders on the buy side and the number of shares for Market 
On Close, Limit On Close, and offsetting Imbalance Only orders on the sell side 
eligible to be matched at the Current Inside Match Price.  
 
For the opening and closing crosses, the Number of Shares of Imbalance may 
be zero-filled under the following scenarios:  
 
• There are no on-open/on-close orders in the NASDAQ book. In this case, the 
Imbalance Side field would be set to “O”.  
 
• There is no imbalance; all shares in eligible orders can be paired at current 
inside match price. In this case, the Imbalance Side would be set to “Nolmb”.  
 
Note: Market Depth qualification is required to use this field 
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Number of Shares Paired The total number of shares that are eligible to be matched at the Current 
Inside Match Price. 
 
For the Opening Cross, this calculation will include early "Regular Hours", 
Market On Open, Limit On Open, and Imbalance Only orders that are eligible 
to be matched at the Current Inside Match Price. 
 
For the IPO and trading halt opening process, this calculation would include 
regular hour orders and quotes that are eligible to be matched at the Current 
Inside Match Price. 
 
For the Closing Cross, this calculation will include Market On Close, Limit On 
Close, and Imbalance Only Orders that are eligible to be matched at the 
Current Inside Match Price. 
 
The Number of Shares Paired may be zero-filled under the following two 
scenarios:  
 
• There are no on-open/on-close orders in the NASDAQ book. In this case, the 
Imbalance Side field would be set to “O”.   
 
• There are no shares in the eligible order types that match at the Current 
Inside Match Price 
 
Note: Market Depth qualification is required to use this field 

Old Set IV Yesterday's Implied Volatility at the close price. 

Open Opening price 

Open Interest Options: The number of outstanding option contracts in the exchange market  

Option Type For options only, either Put or Call 

Option Type (S/NS) Option delivery type, S=Standard, NS=Non Standard, i.e. Adjusted deliverable 

Optional Security Defines if options are available for the security 

Payout Ratio Common and Preferred Stock Dividends Paid / Net Income, on a trailing 12-
month basis 

PE Price per Share / Earnings per Share 

PEG Ratio (( Last Close Price / Mean EPS Estimate Current FY ) / Long Term Growth Rate ).  
If this result is less than zero, PEGRatio is set to null/blank. 

Prev Net Change Price change during the previous trading session 

PrevDay High Highest trading price during the previous trading session 

PrevDay Low Lowest price traded during the previous trading session 

PrevDay Open Opening price from the previous trading session 

Previous Close Last price the asset traded in the previous trading session 

Price to Book Stock Price / (Total Assets – Intangible Assets and Liabilities), for the last fiscal 
year 

Price to Book (TTM) Stock Price / (Total Assets – Intangible Assets and Liabilities) on a trailing 12-
month basis 
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Price to Book Qtr Stock Price / (Total Assets – Intangible Assets and Liabilities), for the most 
recent reported quarter. 

Price to Sales Stock Price / Revenue per Share, on a trailing 12-month basis 

Price Variance Indicator This field indicates the absolute value of the percentage of deviation of the 
Near Indicative Clearing Price to the nearest Current Reference Price.  
 
Price Variance Indicator = (Near Indicative Clearing Price – Current Inside Price)  
 
This field indicates the % difference between the indicative Opening/ Closing 
Cross price (Near Clearing Price) and the price where the market is currently 
trading. A high value indicates there will be a large price difference between 
the Opening/ Closing Cross price and the continuous market if sufficient 
offsetting interest is not entered. This field will display a percent difference or 
percent range as listed below: 
 
Code  Percentage Range  
L        Less than 1%   
1        1 to 1.99%   
2        2 to 2.99%   
3        3 to 3.99%   
4        4 to 4.99%   
5        5 to 5.99%   
6        6 to 6.99%   
7        7 to 7.99%   
8        8 to 8.99%   
9        9 to 9.99%   
A        10 to 19.99%   
B        20 to 29.99%   
C        30% or greater   
Space Cannot be calculated 
 
Note: Market Depth qualification is required to use this field 

Profit Margin % Profit Margin = Net Income / Net Sales (revenue) 

QTD $ Change $ change of current price to closing price at the end of the previous quarter 

QTD % Change % change of current price to closing price at the end of the previous quarter 

QTD Div Paid The sum of the cash dividends which have gone ex in the current quarter. 

QTD%RetAdj Percentage change between current price and last price of previous quarter - 
[(current price / previous quarter's end price) – 1] * 100 

QTD%TotRetAdj Percentage price change between current price and last price of previous 
quarter, plus any dividends received for that period [(current price + QTD cash 
dividends) / previous price] * 100 

Qtr Prev Close The price as of the last workday of the previous quarter 

Quick Ratio (Total Cash and Short Term Investments + Accounts Receivables + Other 
Receivables) / Total Current Liabilities, on a trailing 12-month basis 

Recent Last Trade or Settlement, whichever is more current. 

Rho Measures the expected change in the option Premium, given a 1% change in 
the Domestic Interest Rate. 

ROA (TTM) (EBIT * 0.625) / ((Total Assets (t) + Total Assets (t-1)) /2), on a trailing 12-month 
basis 
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ROE (TTM) Earnings From Continuing Operations / ((Total Equity (t) + Total Equity (t-1)) 
/2), on a trailing 12-month basis 

Root Options: Complete symbol of the underlying asset 

RSI The internal strength of an instrument as compared to former prices over a 
period of 14 days. 

Sales (TTM) Total Revenue on a trailing 12-month basis 

Sector Economic sector 

SEDOL The Stock Exchange Daily Official List number, a code used by the London Stock 
Exchange to identify foreign stocks, especially those that aren't actively traded 
in the U.S. and don't have a CUSIP number. 

SellerID The TSX assigned ID number for the broker on the sell-side of a trade 

Shares Number of outstanding shares 

Shares Outstanding Number of outstanding shares, in millions 

Short Int Mo % Chg Compares short interest from two months. If the latest reported short interest 
is midmonth, it will be compared to the previous midmonth short interest. If 
the latest reported short interest is end-of-month, it will be compared to the 
previous end-of-month short interest. The month short interest percent is a 
percentage. 

Short Int Mo Chg Compares short interest from two months. If the latest reported short interest 
is midmonth, it will be compared to the previous midmonth short interest. If 
the latest reported short interest is end-of-month, it will be compared to the 
previous end-of-month short interest. The month short interest change is an 
absolute value 

Short Int Ratio Latest reported short interest divided by 25-day average daily trading volume 

Short Int YTD % Chg The percent change between latest reported short interest and the last short 
interest reported the previous year. 

Short Int YTD Chg The YTD short interest change is the absolute change between the latest 
reported short interest and the last short interest reported the previous year. 

Short Interest Latest exchange reported short interest (mid-monthly periodicity) 

Short Volume Short Volume is a daily value, derived from short sale activity occurring in the 
US markets. We currently support the composite volume occurring on Nasdaq 
and its Boston Stock Exchange for trades of NYSE and Nasdaq-listings. 

Side of Imbalance The Imbalance Side field indicates the market side for of the imbalance. This 
field will display the following values for a specific security:   
  
Code Description  
B Buy-side imbalance  
S Sell-side imbalance  
Nolmb No imbalance (buy side equals sell side)  
O No marketable on-open (or on-close) orders in NASDAQ, thus no  imbalance.  
 
Note: Market Depth qualification is required to use this field 

Split Date Date of Split (“Ex-Date”) 

Split Ratio Total Current Assets / Total Current Liabilities, on a trailing 12-month basis 

Strike Options: Strike price 

SV Date The previous trading session’s date 
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Symbol A unique alpha numeric value used to identify the security. 

Theoretical Price The value of an option as calculated by the option pricing model using the 
previous sessions closing implied volatility. 

Theta Reflects expected change in the option Premium, over one day (Measure of 
time value decay). 

Tick Either + or - to representing the change from the previous Trade Price when 
instrument is currently trading and a "C" when the session is closed for 
Equities and Options and a "S" when Futures contracts are settled 

Time Time of the last update (Includes Bids / Asks) 

Time Value Difference between the option last price and its intrinsic value.   Only 
calculated when intrinsic value is defined. 

Tot D/E (TTM) Total Debt / Total Equity on a trailing 12-month basis 

Trade Exchange Exchange, market center, where last trade occurred 

Trade Size Quantity of last trade 

Underlying symbol Options: Complete symbol of the underlying asset 

Vega Measures the expected change in the option Premium, given a 1% change in 
the Implied Volatility of the option (Measures sensitivity to shifting volatility 
levels). 

Vol Avg 10D The average volume over the most recent 10 business days, U.S. holidays and 
weekends excluded. 

Vol Avg 25D The average volume over the most recent 25 business days, U.S. holidays and 
weekends excluded. 

Vol Avg 3Mo The average volume over the most recent 90 business days, U.S. holidays and 
weekends excluded. 

Vol Avg 50D The average volume over the most recent 50 business days, U.S. holidays and 
weekends excluded. 

Vol Avg MTD The average month-to-date volume for the business days in the current month 

Volume The number of shares traded from the current day's market opening until the 
reported trade time.  

VWAP Volume weighted average price, based on 3 minute frequency. 

Yield Indicated annual dividend divided by the last trade 

Yr Prev Close A security’s prior closing price on the last workday of the previous year 

YTD $ Change $ change of current price to closing price at the end of the previous year 

YTD % Change Percentage Change since Jan 1 of Current Year 

YTD Div Pd The sum of the cash dividends which have gone ex in the current year. 

YTD%RetAdj Percentage change between previous closing price and last price of previous 
year - [(current price / year-end price) – 1] * 100 

YTD%TotRetAdj Percentage price change between previous closing price and last price of 
previous year, plus any dividends received for that period - [(current price + 
YTD cash dividends) / year-end price] * 100 

 



Page 22 | Option Chain 3402200 

 
 

 

https://olui2.fs.ml.com/Publish/Content/application/pdf/GWMOL/riskstoc_supplement.pdf
https://www.sipc.org/
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